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Introduction

The AVANT A2D+ Audiometer represents a new era of ultra compact diagnostic audiometry for your
office. Compact yet rugged, this PC-Based system is USB powered and supports current ANSI and IEC
audiometric tests. This manual assumes that the system hardware, software and drivers are installed and
working properly. Please refer to the MedRx AVANT A2D+ Audiometer Installation Manual for assistance.
The Installation Manual is included in the original AVANT A2D+ Audiometer packaging in both printed and
PDF formats.

The scope of this manual is to get you “up and running” with the AVANT A2D+ Audiometer System.
Please consult the interactive Help System within the software for more detailed information of features
and functionality. To access this tool, press the F1 key at any time, or click the Help icon or text menu
with your mouse. Access these by clicking on the “Help” tab at the top of the screen, and select “Help
Topics”. Select an item from the list in the Index tab, and click “Display”.

This unit is a Type 2 AE audiometer that meets the requirements of both ANSI S3.6 and IEC 60645-1 and
IEC 60645-2 Those standards specify the required precision that the Avant A2D+ does achieve.
Measurement uncertainty is +/- 1 dB. This device and transducers are intended for use at test frequencies
between 125 Hz and 8000 Hz.

The Avant A2D+ Audiometer is an electronic instrument intended for the testing of human hearing using
both Tone and Speech audiometry. This device meets the specifications and tolerances for audiometers
and standard reference threshold levels for audiometric transducers such as supra-aural, circumaural,
and insert earphones; bone vibrators; and loudspeakers as defined in ANSI S-3.6 and IEC 60645.

The Avant A2D+ Audiometers are typically used to measure patient hearing loss, the degree of hearing
loss, and to create audiograms that will be used by the manufacturer of hearing aids to set the correct
gain levels for various frequencies.
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The AVANT A2D+ Audiometer Software Overview

General Overview

The AVANT A2D+ Audiometer software can run stand-alone or from NOAH™ System or the TIMS®
NOAH-Compatible Office System.

Launching the Software

Stand Alone NOAH

ATD

Fi!
e 200

e Double click the AVANT shortcut on
your Windows Desktop

e Launch NOAH.
e Launch Avant A2D module following NOAH
procedures.

Software Options

Basic Options
Several options are available which allow the user to customize the AVANT A2D+ Software to meet their
needs.

Access these options from the File Menu on The Options may also be accessed
the AVANT A2D+ Main Screen as shown from the Audio screen by clicking on
below. the Options text menu as shown
below.
B Avant A2D+ | a -
- Avant A2D+ - Audiometry [Audiogram]
Function Hel

m i Eile Function Ear Output Audic Stimulus

Print Setup...

Page Setup... Aoty SRT Wh Shenger

Clear Sezsion Data

Advanced Options...

Exit
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The screen shots below detail the Basic Options available in the AVANT A2D+ software.

i R r
Options u Options ﬂ
View | Audiometry | MHA/HLS | Tymp | View  Audometry | MHAHLS | Tymp |
Amow Buttons ————————————
~Plot————————————— Speech Spectum ————————— & =
& Move Up by (dB): Iﬁ Default Level (dB):
¥ Cance =
¥ Horizortal Grid 7 5p — Mave Down by (dB): I‘H} 3, Default Output: IP;C-1 vl

—Sight lerrErs ' Auto Sound Default Tone: IContinuous 'l
Style: ILlnes ]' I‘DE{E"-'|t> ;I I Reverse Keyboard Aows Speech Scoring: IStandard vl

- .I5ﬂ ize: |12 I l
Size: Font Size: & Default Speech Input: |File =

[ Reverse Level Cortrols

- Level Unit V¥ Auto Advance Words, Limit: |25- vl
Default Ear: IRJ it vI :
[¥ Dual Plot Mods g 5B " 1dB

L rves T eaum = [ Enable Operator Headset
v Maintain Plot Ratios [V Use Plat Antizlizsing ¥ Enable Talkback Microphone

ok | Conce | . | ok | Cancel | Hep |

The View tab allows you to set the default The Audiometry tab sets the look and
appearance of the test environment. behavior of the A2D+ audiometer.
rOpt'lcuns u ert’lons u
View | Audiometry MHA/HLS | Tymp | View | Audiometry | MHA/HLS  Tyme |
~MHA
Output: - =
Default Level: |50 -5 [V Auto Switch Modes
MHA Simulation: INorrnal vI ¥ Interpolate Curve
[ Allow Muttiple Records
~HLS
Output: [Free Field - Line Out ~|
Default Level: |50 =
HLS Simulation: INorrnaI 'I

ok | Cancel | o Heb | oK | Cancel | Hep

The MHA/HLS tab sets the default look If your system has a Tympanometer
and behavior of the Master Hearing Aid connected, this tab will assist in
and Hearing Loss Simulator. configuring the look of the display.

NOTE: Remember, that more information is always available in the Interactive Help System by clicking
the Help Icon or pressing the F1 key.
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Advanced Options

The Advanced Options screen allows you to
configure your system to meet your individual

clinical needs. It also provides MedRx

Technical Support with tools for helping you

troubleshoot technical issues. Access this

screen from the File Menu on the Avant Main

Screen as shown to the right.

m Avant A20+ -

m Function Help

Print Setup...
Page Setup...

Clear Session Data

Opticns...

Advanced Options...

Exit

The key features of each tab are described below. For more in-depth information, consult the
interactive Help system within the software by pressing the F1 key or clicking the Help icon.

The General Tab configures the overall
AVANT A2D+ Audiometer behavior with
respect to other Windows programs,
specifically NOAH.

Advanced Options.

General I Audio  Video wTympanumaﬁrﬂ

Otoscope Input
Device: [ < |

Atemative Input

Device ~|

o |

Carcel | Hep |

If your system has a Video Otoscope, the

Video tab allows you to select the appropriate

device driver.
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Advanced Options léj Advanced Options &J
General ]Aud\n ]\nden ]Tympannmetry General Audio W\ﬁdeu ]Tympanomary]
(1T s S Speakers (2- USB Audio Device) - AZD+ hd
CD-ROM Drive: |D: hd
Input Device:  [Line (2- USE Audio Device) - A2D+ ~|
I Output Mixer: [2- USB Audio Device -l
I Home Directory Calibration Data Input Mixer: |2— USB Audio Device ﬂ
Language N } ; !
Pere Microphone Gain (dB): |12 + Set Defaults ‘ Audio Properties |
Control Panel
System Information
oK Cancd | e | oK Carcdl | Hop |

Use the Audio Tab to select the proper audio

device for your A2D+ Audiometer. This tab also
provides access to the Windows Audio controls.

r)\\d‘.ranced Cptions &J
General | Audio | Video  Tympanometry |
Tympanometer: ’—4|
'
[ ok | cacel | W |

If your system has a Tympanometer

connected, use this tab to identify it and ensure

the driver and software that control it are
correctly installed.



Preparing for Testing

s — Connecting the Peripherals
el ¢

Connect the peripherals before testing a patient.
Using the pictures below, locate each of the

~ Pationt Response USB =

- To e e R E accessories and plug them into the unit as shown
E here.

T & N

U > 1 =1 If you are installing the A2D+ Audiometer outside

of a sound booth, connect the Patient Response,
Talkback Mic, Bone Conductor, Speakers and
Earphone cables to the inside of the patch panel
and then connect your patch cables from the
outside of the patch panel to the A2D+ as shown.
If your booth did not include patch cables these are
readily available from electronics or stereo stores,
or from MedRx.

To install the A2D+ Audiometer inside the booth,
simply reverse the above, connecting the operator
side cables (USB, Operator Mic, and Monitor) to the
patch panel. In most booths, the USB cable will
need to pass through the booth and be packed with
foam and caulking. Consult your booth installer for
specific instructions.

o
prs

Insert Earphones Headset optional Bone Conductor Talkback Microphone

4

-~

Patient Response Operator Mic & Monitor USB Cable
Switch
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Use the accessories provided with your Avant A2D+. Typical acceptable transducers are shown on the
“Preparing for Testing” page in the training manual. Operator headsets for use with the Avant A2D+
should have 32 ohms impedance and the speaker power should be at least 50 watts. Air conduction
transducers for use with this device should have an impedance of 10 ohms. The speaker voltage should
match the local mains voltage where the device is used.

The Operator Headset with microphone is used by the device operator to communicate with the patient.

The patient talks to the operator using the Talk-Back microphone. O\

Placing the Earphones on the Patient

The Avant A2D+ standard configuration includes Eartone 3A Insert Earphones. TDH 39 earphones are
also available by request. The figures below illustrate how to properly place these earphones on the
patient.

Eartone 3A Insert Earphones

IMPORTANT: The foam tips used for the Eartone 3A earphones are for SINGLE PATIENT USE ONLY.
Do not attempt to wash and re-use them.

1. Place a new set of foam tips on the earphone tubes as shown.
These tips are designed for single patient use and should not be
washed and reused.

e NOTE: When removing foam tips after use, be sure the clear
plastic tubing nipple remains attached to the long earphone
tube.

2. Carefully compress the tip between your
fingers to allow it to fit into the patient’s
ear canal as shown. Do not roll the tip
between your fingers.

3. Pull up and back on the patient’s pinna to
straighten the ear canal.

4. Place the compressed foam tip deep
within the ear canal.

5. When properly placed, the outer surface
of the insert tip will be flush with the
opening of the ear canal as shown.
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TDH Earphones

Placing the Bone Conductor

N

Sound Field Testing

1. Place the earphone on the patient’s
head so the center of the earphone is
directly over the opening of the ear
canal.

2. Adjust the headband so the
earphones remain in place, but be
careful not to make it so tight as to
cause patient discomfort.

Locate the mastoid process behind the pinna. This is
the bony shelf just behind where the ear meets the
head.

Carefully place the bone conductor on the mastoid
process and hold it in place.

Place the headband over the head to the opposite
temple.

Carefully and slowly loosen your grip to check if the
bone vibrator and headband will stay in place.

If either moves, reposition until both the headband and
bone vibrator are secure.

The Sound Field speakers (Free Field) should be connected using optional or user supplied amplifier and
speakers. They should be calibrated annually as per ISO 8253-2, located at least 1 meter from the patient

ear and at the same height.

Device Maintenance

Annual re-calibration of the transducers used with the Avant A2D+ is recommended. There are no user

repairable components of this device.

Refer to the Installation Manual for care and cleaning instructions.
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Performing Audiometric Testing

The screen shot below shows the controls which are available from the Audiometer main window. The sections
of the manual that follow explain how to use these tools to perform hearing evaluations using your A2D+
Audiometer.

“ Avant A2D+ - Audiometry [Kudiogram] — = |EI| X|
File Function Ear ©Output  Audio  Stimulus  Options... Tools  Help
‘ Audiometry ‘ SRT ‘ DS ‘ ‘ Stengat ‘ ‘ QuickSIMN ‘ m a
S
Test ) )
105 dB ﬁ‘v Jﬁ
_ Left Ear Right Ear
HL [ d ] HL[dB ] 500Hz 105dB :JJ
- . - AR
0 07 i EARTone | BC FF
10 10
: > v th ] \ th
20 ’ 2} D & \ A, AD AuD || ucL | ML
30 ; g i 0 ; X g R
5 d | ch 2 - T & 7 I
- TS DA || ] eyl s TR
50 ] D 50 ] ‘\ 5 Tone | ‘Warble || NEBN
B0 £0 o~
70 70 ——
0 a0 : ‘\ Font ‘4
30 A 50 -
i P ] U U ° °
100 100
d 1 1 1 ::hu/’ 3 -
110 110 . ) -
120 120 - T
125 250 00 A0k 15k 2k %k 4k Gk 12 500 701k 152k 3k 4k 6k 9 ‘ . . Mk J‘
I w&m v
Frequency [ Hz | Frequency [ Hz | 5 E)| s 7
I i Lock
PTA Lefi: 36dB, PTA Right: 36dB
Ar Conduction, AI=35%, PTA=36 »  SRAT DS Unaided DS Aided MCL  UCL
Bone duction, PTA=35 Left:
L lewel .
Air Conduction, AI=35%, FTAS36 Right:
Baone conduction, PTA=33 Both:
L lewel
1. Test selection tool bar 8. No Response button
2. Ear selection 9. Test Interrupter
3. Output selector 10. Back
4. Test Type Selector 11. Help
5. Tone Type Selectors 12. Discard
6. Output Level Potentiometers 13. Talk Over
7. Masking interrupter and routing selector 14. Legend
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Pure Tone Audiometry

Pure Tone Audiometry measures the patient’s peripheral hearing sensitivity, or the softest levels they can
hear pure tones at a variety of frequencies. These thresholds are plotted on a standard graph called an
audiogram. The AVANT A2D+ Audiometer software controls the hardware, stores the data (if running
within NOAH or TIMS) and prints a standard audiogram report. Pure tone Audiometry can be performed
via earphones or a Bone Conductor (Bone Conduction).

Prerequisites:

e Before performing audiometry, careful inspection of the ear canal should be performed. This is
best done with Video Otoscopy. After ensuring the ear canal is clear, place the appropriate
transducer on the patient as shown on page 7.

Pure Tone Audiometry via Earphones (Eartone 3A Inserts or TDH 39)

1. From the main A2D+ Window, click the | & % button on the right side menu bar.
Audiomatry
2. By default, the L+ button will be selected once you enter the main Audiometry Screen.
Other default settings (based on typical clinical practice and procedures) are:
a. Right Ear

b. AC (Air Conduction)
c. Tone Stimulus
d. Continuous Tone

3. Instruct the patient that they will hear several very quiet (soft) tones (beeps) and that they should
signal (raise their hand, press the patient response button, etc.) as soon as they hear it. Itis
helpful to also say “even if it seems very far away”.

4. Begin at 1000 Hz in the Right ear (unless the patient reports better hearing in the left ear).

@ Test
5. Present a tone at 60 dB by pressing the space bar or clicking the % button.

6. If the patient does not hear the tone (does not signal), raise the level 5 dB using the up arrow on
your keyboard and present again.

7. Repeat step 6 until the patient signals that they hear the tone.

8. When the patient signals they hear the tone, decrease the level by 10 dB and present the tone
again.

9. Repeat steps 6 through 8 until the patient responds to a tone at the same level 2 times with the
level ascending.

10. Using the right arrow key, change the test frequency to 2000 Hz and repeat steps 5 through 8 to
establish the threshold at 2000 Hz.

a. NOTE: If the threshold at 2000 Hz is more than 20 dB different (less than or greater than)
the threshold at 1000 Hz, repeat steps 5 through 8 at 1500 Hz (the “half octave” between
1000 Hz and 2000 Hz).

11. Repeat steps 5 through 8 for 4000 Hz, 8000 Hz, 500 Hz and 250 Hz.
12. Repeat steps 5 through 11 in the opposite ear.

NOTE: The software automatically calculates the 3-frequency Pure Tone Average (PTA) which is
displayed above and inside the legend as follows:
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PTA Right: 60dB

Ar Conduction, AI=0%, PTAEE0 |

Pure Tone Audiometry via the Bone Conductor

1. Following the instructions on page 9, place the Bone Conductor on the mastoid process behind
the ear with better air conduction thresholds as measured above. If the thresholds are equal,
place the Bone Conductor on the mastoid process behind the right ear.

2. Establish bone conduction thresholds as described above (see page 11, steps 5-8) for 1000 Hz,
2000 Hz, 4000 Hz, 500 Hz and 250 Hz.

3. If the Bone Conduction (BC) threshold at a given frequency is less (better) than the Air
Conduction (AC) threshold by 15 dB or more, you must confirm the threshold by performing

masking.

Masking for Pure Tone Audiometry

There are several accepted methods for masking. This manual will not promote one over another,
however, to use the masking function on the AVANT A2D+ Audiometer, follow the steps below:

b

Test M azk
B85dB || 50dB
-~

-\_R%

=1 [[F= |
B +5([ B 45
;£< o Lock%

1.
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Click the Masking button. The red light will appear
indicating that the masking is on.

Use your mouse to adjust the Masking Level slider shown
on the left to the appropriate level based on your preferred
method of masking.

If you wish to maintain the balance of signal and masking
(for example, masking always 30 dB above the signal),
click the Lock button after setting the masking and signal
levels.

The default for pure tone audiometry is to deliver narrow
band masking to the ear opposite the test ear. If you wish
to use a different stimulus, or route the masking to the
same or both ears, click on the arrow to the right of the

12



4 Masking On button.
| ] [ ) P -||
fl v Opposite Ear 5. Use your mouse to select the new masking type and
| AT routing for your specific application.
Both Ears
v Narrow Band Noice 6. When you are finished making changes to the Masking,
1 Speech Weighted Noise click Close.
| White Noise
1 v EARTone
TDH39
BC
FF
Cloze

Speech Audiometry

Speech audiometry evaluates how well the patient can hear and understand speech. The typical test
battery includes tests of speech threshold and tests of speech discrimination.

The sections below detail how to perform these tests on the AVANT A2D+ Audiometer.
Speech Reception Threshold (SRT)

The Speech Reception Threshold (SRT) is defined as the lowest level at which the patient can repeat
Spondee words with 50% accuracy. Spondee words are two syllable words with equal vocal emphasis
on each syllable such as “baseball” or “hotdog.”

Instruct the patient that they will hear a series of two-syllable words that will get quieter as the test
progresses. They are to repeat the words as best they can, even if they sound very far away. If they are
not sure of a word, they should take a guess.

SRT is typically 10 dB more or less than the patient’s Pure Tone Average, which is displayed on the lower
left of the screen. Set the level of the test signal to 10 dB above the PTA and follow the steps below.

1. From the Avant A2D+ main screen, click
the Audiometry button.

2. Click the SRT button located on the

SRT

toolbar on the top of the screen.
Iy
‘ \word List 3. Click the Word List button.
peh Aoy ol 4. Select Spondee Word Lists A&B from the
list.

5. Click Start Test.

PBK-50 List 3 Form A

Start Test Cancel Help
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feeterg 6. Click the Play button or press the F9 key

padiock

ek pond to present a word. The word will play
g through the chosen transducer as well as
i display on the screen.
oatmeal
o
< e
®  Sooe | B0 7. If the patient correctly repeats the word,
| Total | B click the Correct icon or press F7.
Comect; 3
o Sist Signal Gemes: [ g 8. If the patient incorrectly repeats the word,

click the Incorrect icon or press F8.
Note that the score is calculated and displayed automatically.

If the patient exceeds a 50% score at a given presentation level, stop the test and decrease the level by
10 dB and repeat the steps above.

If the patient fails to achieve a 50% score after 6 words at a given level, stop the test, raise the level 5 dB
and repeat the steps above.

When the patient scores 50% at a given level, the test is complete. The software automatically plots the
score on the SRT graph.

Speech Discrimination (DS)

Speech Discrimination (DS) is a discrimination, or recognition type test using speech as the stimulus. DS
testing measures the percentage of mono-syllable words repeated correctly from a phonetically balanced
list. Unlike the SRT test, the DS test is performed at a fixed intensity (dB) level. Typical patients will
score their best on DS testing at a level between 35 and 40 dB above their SRT.

Before beginning the test, instruct the patient that they will hear a series of one-syllable words. They are
to repeat the words the best they can. If they are not sure of a word, they should take a guess.

1. From the Avant A2D main screen, click
the Audiometry button.

2. Click the DS button located on the
D [ toolbar on the top of the screen.
‘ p— 3. Click the Word List button.
[ specch usomety = 4. Select the desired Word List from the list.

The W-22 or NU-6 lists are good choices
for typical adult patients. When testing
children, the PBK lists should be used.

Word List:
Spondee Word List AGB

Chidren's Spondee Word List

5. Click Start Test.

PBK-50 List 3 Form A

Start Test Cancel Help
A2DM-I-MA2DPT-1 AVANT A2D+ Training Manual 14

Effective Date: 6-12-2014



6. Click the Play button or press the F9 key
Flay to present a word. The word will play
through the chosen transducer as well as
display on the screen.

»  Seore | 50% 7. If _the patient Corr_ectly repeats the word,
Total | B click the Correct icon or press F7.
Comect | |
Correct: = 3 ) )
Start Signal Incorest: [ = 8. If the patient incorrectly repeats the word,

click the Incorrect icon or press F8.

Note that the score is calculated and displayed automatically. The test is complete when all words in the
list have been presented. The software automatically plots the score on the DS graph.

9. Click the Advance button >> or press the
S F10 key to present the next word. Score
accordingly as described above.

QuickSIN
Purpose of the QuickSIN

The primary complaint of hearing-impaired persons is difficulty hearing in background noise. The
measurement of SNR loss (signal-to-noise ratio loss) is important because speech understanding in noise
cannot be reliably predicted from the pure tone audiogram (Killion & Niquette, 2000).
The QuickSIN test was developed to:

e Provide a one-minute estimate of SNR loss

e Provide a quick way for clinicians to quantify a patient’s ability to hear in noise

o Determine if extended high frequency emphasis improves or degrades understanding of speech
in noise

e Assist professionals in choosing appropriate amplification and other assistive technologies
o Demonstrate that hearing aids with directional microphones improve speech intelligibility in noise
¢ Provide a large number of equivalent test lists for use in clinical and research work
¢ Provide information useful in counseling patients regarding realistic expectations
Performing the QuickSIN

e From the Avant
A_2D+ main screen, _—_ . ; e Click the QuickSIN
chck_the _ imulus  Options.. Tools Help button on the top of
Audiometry icon. the Audiometry

Shanger CuickSIN screen
The screenshot below shows the key features of the
QuickSIN. 4. List Selector
1. Calibration Button 5. Track Display
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2. Ear Selector 6. Track Control

3. Output Selector 7. Test Type Selector
B v 25+ - : ~— . N E—— -
File Function Ew Output Audic Stimuls Options.. Tools Help
pe— sa1 wR Stenger kSN T - Wy @
f
List 1 2 @ s 9
Tracks SN Score | - Let || Figh | Bah
BN 1. A while silk jackel goes wilh any shoes .
<} 2. The child crawled into the dense grass SM 20 i g 1]
= 3. Footprints showed the path he ook up the beach SIN 15 - @ EARTone | TOH33
= 4. A vent near the edge brought in fresh air @ SN 10 . 4
< 5. Itis a band of steel three inches wide SN 05 . FE
+' 6. The weight of the package was seen in the high scale S/N 00
.}
<< Play >>
255- TOTAL= 255 SNR loss @
Select a sentence... Score .
[ 2= =
s
Let Right
No PTA available. Please perform Tone Audiometry test
[ ] x <=
Tl Qe Discard Help Back.
List 1 HFE/List 2 HFE LP 1. Select alist from the List
List 3 HFE /List 4 HFELP . .
List 5 HFE /List 6 HFE-LP Selection Window one of

List ¥ HFE /List 8 HFE-LP the fO||OWIng tWO WayS

e Click the list, then click Select.
e Double-Click the list number.

QuickSIN HFE

List 1 HFE/List 2 HFE-LP 2. Play the first sentence in the
Tracks SN [Score |- list by clicking the Play

B A whi sk acket goes wihany shoes————— [UES

2 2. The child crawled into the dense grass SIN 20 bUtton -

2 3. Footprints showed the path he took up the beach SIN 15 Ask the patient to repeat the
2 4 Avent near the edge brought in fresh air S/N 10

1) 5. Itis a band of steel three inches wide S/N 05 3 sentence.

2 6. The weight of the package was seen in the high scale S/N 00

2 7. Tear a thin sheet from the yellow pad SIN 25

2 8_A cruise in warm waters in a sleek yacht is fun S/N 20

2 9. A sireak of color ran down the left edge SIN 15

2 10. It was done before the boy could see it SIN 10

2 11. Crouch before you jump or miss the mark SIN 05

(List 1 HFE) 25.5 - TOTAL= 25.5 SNR loss / (List 2 HFE-LP) 25.5 - TOTAL= 25.5 SNR loss
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List 1

Tracks SIN Score l;l
1y 2. The child crawled into the dense grass SIN20 4
14 3. Footprints showed the path he took up the beach SIN 15 3
14 4. A vent near the edge brought in fresh air SIN 10 3
1y 5. Itis a band of steel three inches wide SINOS 2
<< Play >

25,5 - TOTAL= 7.5 SNR loss (Average SNR loss = 7.50)

Moderate SNR loss. Directional Micropheones help. Consider array mic.

The weight of the package was seen in the high scale Score
r R r ror -

Lett

Right |
List1; Unaided AC: Level=70dE: SMNR loss=7.50 dB

List 1
Tracks SIN Score lﬂ
<}y 2. The child crawled into the dense grass SIN20 4
) 3. Footprints showed the path he took up the beach SIN 15 3
< 4. A vent near the edge brought in fresh air SIN 10 2
<y 5. Itis a band of steel three inches wide SIN 05 1

<< Play >>
25.5 - TOTAL= 10.5 SNR loss (Average SNR loss = 10.50)

Moderate SNR loss. Directional Microphones help. Consider array mic.

The weight of the package was seen in the high scale Score

B m m E N ol

3. Score the patient’s response
one of the following ways:

a. Click the check-box of each
correct key word with your
mouse. This will record the
total number of correct key
words in the Score pull-
down.

b. Record the total number of
correct key words using the
Score pull-down or by
pushing 1-5 key on the
keyboard.

4. Click the next sentence and then
click Play or click >>. This will
advance & play.

5. Repeat steps 2-4 until all 6
sentences in the list have been
played and scored.

After all six sentences are
scored, the following results
are displayed:
e Total SNR Loss in dB.
¢ Recommendations.

Additional information on interpreting the QuickSIN is available in the Interactive Help system.

Top access this, click the Help icon or press the F1 key.

Hearing Loss Simulator

The Hearing Loss Simulator demonstrates the effect of the client’s hearing loss for the significant
third party. The program attenuates an input signal to simulate the audiogram. The third party
listens to the free field speakers. The third party can hear how their own voice is distorted by the

hearing loss when the Record input option is used.

The Hearing Loss Simulator requires the client’'s Audiogram data. This data can be manually entered in

the Audio screen of this or any other task.
How to perform the Hearing Loss Simulator task

1. Select the Hearing Loss Simulator tab on the toolbar.

2. Enter the Audiogram values manually if the data is not automatically imported to this screen.

3. Select the input signal type: Mic, File or Record. Select the track and the Play button on the control
panel. See below for instructions on how to use the Record option.

The HLS output is directed to the free field loudspeakers.

4. Select Normal to play the input signal as a person with normal hearing would perceive it. Select
Simulated to turn on the simulation of the client's hearing loss. Toggle between these selections as

necessary.
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5. The Reset option restores the audiogram to the original state. Use this option if you have modified
the audiogram while in the simulate mode but want to undo the changes. The changes to the
Audiogram that are made on the HLS screen are temporary and will not affect the client's original
audiometry record.

6. A volume control adjustment bar allows modifying the audio for manual adjustment of the output level
of the free field speakers. This allows the practitioner to demonstrate improvements to hearing loss
with amplification or what happens when further hearing loss occurs.

7. To stop the playback, select the Stop button on the player.

Note: It is recommended you use a variety of tracks from the list to demonstrate the hearing loss.
Record Input Option

This option allows recording and play back of the voice of the third party.

Note: The LSM option appears on the bottom half of the display. This is so the unaided and aided results
can be displayed simultaneously for the patient and significant third party.

Master Hearing Aid

Master Hearing Aid is an alternative to using a stock hearing aid to demonstrate the benefits of
amplification to an inexperienced user. The system applies the fitting rules by default to the patient's
audiogram and simulates a hearing aid. The patient listens to this signal through the headphones.
Options for editing the gain applied to the audiogram are provided.

About the Master Hearing Aid Display

The Master Hearing Aid screen displays a graph with dB Gain on the vertical axis and Frequency in Hz
on the horizontal axis. The plot on the graph represents the gain applied to the patient’s Audiogram. The
NAL-RP is applied by default. A new rule can be selected from the list on the right side of the display. A
volume adjustment bar allows for manual adjustment of the output level. The control panel on the right of
the display provides options for input signal source and the task icons for Normal and Simulate.

The Master Hearing Aid applies gain separately for each ear. If audiogram values are entered for the
left and right ear, the selected fitting rules will be applied to each ear separately. Different rules may be
entered for different ears (i.e. NAL-RP for left ear and BERGER for right ear). If an audiogram is entered
only for one ear, the gain will not be adjusted for the opposite ear and the sound for that ear will be
normal.

If Binaural mode is selected, the sound will be heard from both channels (left and right). If Monaural
mode is selected, the sound will be heard only from the channel corresponding to the active ear when the
channel for the opposite ear will be muted.

Input signal

Live voice (microphone) allows you to use the right probe mic for live speech input to the headphones.
The clinician or significant third party can speak into the microphone for this activity. Note: there is a
processing delay between the input and playback. Make sure that the client cannot hear the voice directly
but only through the headset. If this is not possible, use the Recorder (describer below) to simulate
speech input.

File allows the user to play sound files. The program supports MP3 and WAV files and comes with a
preset MedRx Sounds Sensations set of files. After the option is activated, use the player panel to control
the playback.
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CD allows the user to play music CDs. After the option is activated, use the player panel to control the
playback.

Record input mode allows the clinician or third party to record a sample of their speech which can then
be replayed for repeat comparisons under different amplification conditions for the patient. Refer to the
interactive Help system by pressing F1 or clicking the Help icon to learn more about the recorder.

How to use the Master Hearing Aid:

1. Select the Master Hearing Aid (MHA) icon from the main screen.

2. Enter the Audiogram values manually if the data is not automatically imported to this screen.
3. Select the input signal type: File, CD, Mic, or Record.

4. Select Monaural or Binaural.

5. Select the Normal icon, which will send the input signal through to the inserts without modification.
The patient is listening to the signal without any amplification benefit. Select the Simulate icon to
modify the input signal according to the selected rule. This selection allows the patient to hear the
benefits of amplification. Toggle between these two selections as necessary.

6. If the simulated frequency response needs to be adjusted, based on feedback from the patient,
manually edit the response by clicking on the gain curve at the desired frequency and new gain level.
The gain curve of the selected test ear on the control panel can be edited. To edit the other ear, click
the appropriate test ear icon on the control panel first.

Hint: Use the track return icon on the player control panel to replay one

Tire: | 00:00 > & .
- ™ track continuously.
E The Reset option restores the rule to the original state. Use this option if
you have modified the rule but want to undo the changes.
Printing

Printing within the Avant A2D+ software is very simple.

Pl Avant A2D+ - Audiometry [Audiog From the File menu, click one of the following options:
=8 Function Ear Output Aud

Open ]

Page Setup — Allows you to set margin sizes and the default
text header for your reports.

Save

Clear Session Data

Print Setup — selects the printer you want the report to be

Page Setup.. sent to.
Print Setup... . . . .
S Print Preview — Shows you what your report will look like
print Preview before you print it
Print... € youp ’
Go Back Ctrl-Back Print — Sends the report to the printer. This option opens the
Exit Alt-F4 Windows Print dialog which allows the user to select any
' ' installed printer and modify the properties (quality, number of
copies, etc.) for the print job.
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Limited Warranty

MedRx, Inc warrants this product to be free from defects in material and
workmanship for one year from the time of purchase. If this system fails to perform
as specified during this period, the purchaser is responsible for calling MedRx at
(888) 392-1234 or (727) 584-9600. The company's representative will advise the
owner to either return specific components or the entire system to:

MedRX, Inc.
1200 Starkey Road #105
Largo, FL 33771 USA

MedRx will repair or replace any defective devices, fully test the system and/or
components and ship the system promptly back to the owner. There is no cost for the
repair or return shipping, provided the system is one year old or less and has not
been misused, abused or damaged. Such damage includes, but is not limited to,
dropping, exposure to excessive heat greater than 100°F and water/liquid damage.

Repair or replacement of the system as provided under this warranty is the sole and
exclusive remedy of the purchaser. MedRx shall not be liable for any consequential
or incidental damages or for breach of any express or implied warranty. Except to the
extent of applicable law, any implied warranty, merchantability or fithess of this
product is limited to the duration of this warranty.

MedRx will, at its discretion, service and repair out of warranty products at the
purchaser's request, charging for parts and labor as necessary.

The limited warranty is deemed void if software or hardware is installed on this
product which is not pre-approved by MedRx, Inc. Approved software includes
NOAH" and HIMSA approved hearing aid manufacturer programming modules for
fitting hearing aids.

MedRX, Inc is not responsible for problems resulting from installation of unapproved
software or hardware. In the event of unapproved software or hardware installed on
the system causing a conflict, MedRx will service the product for a fee to be
determined at the time of service.

Any extension of this warranty past the initial one-year warranty is subject to the
following (where applicable).

1. A $300 deductible per repair.

2. Extended warranty does not include cables, connectors or peripherals.

3. Extended warranty of the Video Otoscope covers optics only.
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